1 Creating and Editing a Word Document

Objectives

You will have mastered the material in this chapter when you can:

- Start and quit Word
- Describe the Word window
- Enter text in a document
- Check spelling as you type
- Save a document
- Format text, paragraphs, and document elements
- Undo and redo commands or actions
- Insert a picture and format it
- Print a document
- Change document properties
- Open a document
- Correct errors in a document
- Use Word’s Help
Creating and Editing a Word Document

What Is Microsoft Office Word 2007?

Microsoft Office Word 2007 is a full-featured word processing program that allows you to create professional-looking documents and revise them easily. A document is a printed or electronic medium people use to communicate with others. With Word, you can develop many types of documents, including flyers, letters, memos, resumes, reports, fax cover sheets, mailing labels, and newsletters. Word also provides tools that enable you to create Web pages. From within Word, you can place these Web pages directly on a Web server.

Word has many features designed to simplify the production of documents and make documents look visually appealing. Using Word, you easily can change the shape, size, and color of text. You can include borders, shading, tables, images, pictures, charts, and Web addresses in documents.

While you are typing, Word performs many tasks automatically. For example, Word detects and corrects spelling and grammar errors in several languages. Word's thesaurus allows you to add variety and precision to your writing. Word also can format text, such as headings, lists, fractions, borders, and Web addresses, as you type.

This latest version of Word has many new features to make you more productive. For example, Word has many predefined text and graphical elements designed to assist you with preparing documents. Word also includes new charting and diagramming tools; uses themes so that you can coordinate colors, fonts, and graphics; and has a feature that enables you to convert a document to a PDF format.

To illustrate the features of Word, this book presents a series of projects that use Word to create documents similar to those you will encounter in academic and business environments.

The process of developing a document that communicates specific information requires careful analysis and planning. As a starting point, establish why the document is needed. Once the purpose is determined, analyze the intended readers of the document and their unique needs. Then, gather information about the topic and decide what to include in the document. Finally, determine the document design and style that will be most successful at delivering the message. Details of these guidelines are provided in Appendix A. In addition, each project in this book provides practical applications of these planning considerations.

Project — Document with a Picture

To advertise a sale, promote a business, publicize an event, or convey a message to the community, you may want to create a flyer and post it in a public location. Libraries, schools, churches, grocery stores, and other places often provide bulletin boards or windows for flyers. These flyers announce personal items for sale or rent (car, boat, apartment); garage or block sales; services being offered (animal care, housecleaning, lessons); membership, sponsorship, or donation requests (club, church, charity); and other messages. Flyers are an inexpensive means of reaching the community, yet many go unnoticed because they are designed poorly.
The project in this chapter follows general guidelines and uses Word to create the flyer shown in Figure 1–1. This colorful, eye-catching flyer advertises horseback riding lessons at Tri-Valley Stables. The picture of the horse and rider entices passersby to stop and look at the flyer. The headline on the flyer is large and colorful to draw attention into the text. The body copy below the headline briefly describes key points of the riding lessons, and the bulleted list below the picture concisely highlights important additional information. The signature line of the flyer calls attention to the stable name and telephone number. Finally, the graphical page border nicely frames and complements the contents of the flyer.

**Figure 1–1**
Overview

As you read this chapter, you will learn how to create the flyer shown in Figure 1–1 on the previous page by performing these general tasks:

- Enter text in the document.
- Save the document.
- Format the text in the document.
- Insert a picture in the document.
- Format the picture.
- Add a border to the page.
- Print the document.

Plan Ahead

General Project Guidelines

When creating a Word document, the actions you perform and decisions you make will affect the appearance and characteristics of the finished document. As you create a flyer, such as the project shown in Figure 1–1, you should follow these general guidelines:

1. Choose the words for the text. Follow the less is more principle. The less text, the more likely the flyer will be read. Use as few words as possible to make a point.

2. Determine where to save the flyer. You can store a document permanently, or save it, on a variety of storage media including a hard disk, USB flash drive, or CD. You also can indicate a specific location on the storage media for saving the document.

3. Identify how to format various elements of the text. The overall appearance of a document significantly affects its ability to communicate clearly. Examples of how you can modify the appearance, or format, of text include changing its shape, size, color, and position on the page.

4. Find the appropriate graphical image. An eye-catching graphical image should convey the flyer’s overall message. It could show a product, service, result, or benefit, or visually convey a message that is not expressed easily with words.

5. Establish where to position and how to format the graphical image. The position and format of the graphical image should grab the attention of passersby and draw them into reading the flyer.

6. Determine whether the flyer needs a page border, and if so, its style and format. A graphical, color-coordinated page border can further draw attention to a flyer and nicely frame its contents. Be careful, however, that a page border does not make the flyer look too cluttered.

When necessary, more specific details concerning the above guidelines are presented at appropriate points in the chapter. The chapter also will identify the actions performed and decisions made regarding these guidelines during the creation of the flyer shown in Figure 1–1.

Starting Word

If you are using a computer to step through the project in this chapter and you want your screen to match the figures in this book, you should change your screen’s resolution to 1024 × 768. For information about how to change a computer’s resolution, read Appendix E.
To Start Word

The following steps, which assume Windows is running, start Word based on a typical installation. You may need to ask your instructor how to start Word for your computer.

1. Click the Start button on the Windows taskbar to display the Start menu.

2. Point to All Programs on the Start menu to display the All Programs submenu.

3. Point to Microsoft Office on the All Programs submenu to display the Microsoft Office submenu (Figure 1–2).

4. If the Print Layout button is not selected, click it so that your screen layout matches Figure 1–3.

5. Click Microsoft Office Word 2007 to start Word and display a new blank document in the Word window (Figure 1–3).

6. If the Word window is not maximized, click the Maximize button next to the Close button on its title bar to maximize the window.

What is a maximized window?
A maximized window fills the entire screen. When you maximize a window, the Maximize button changes to a Restore Down button.

7. If the Print Layout button is not selected, click it so that your screen layout matches Figure 1–3.
The Word Window

The Word window consists of a variety of components to make your work more efficient and documents more professional. These include the document window, Ribbon, Mini toolbar and shortcut menus, Quick Access Toolbar, and Office Button. Some of these components are common to other Microsoft Office 2007 programs; others are unique to Word.

Document Window

You view a portion of a document on the screen through a document window (Figure 1–4). The default (preset) view is Print Layout view, which shows the document on a mock sheet of paper in the document window.

The Word document window in Figure 1–4 contains an insertion point, mouse pointer, scroll bar, and status bar. Other elements that may appear in the document window are discussed later in this and subsequent chapters.

Insertion Point  The insertion point is a blinking vertical bar that indicates where text, graphics, and other items will be inserted. As you type, the insertion point moves to the right, and when you reach the end of a line, it moves downward to the beginning of the next line.
Mouse Pointer  The mouse pointer becomes different shapes depending on the task you are performing in Word and the pointer’s location on the screen. The mouse pointer in Figure 1–4 is the shape of an I-beam.

Scroll Bar  You use a scroll bar to display different portions of a document in the document window. At the right edge of the document window is a vertical scroll bar. If a document is too wide to fit in the document window, a horizontal scroll bar also appears at the bottom of the document window. On a scroll bar, the position of the scroll box reflects the location of the portion of the document that is displayed in the document window. A scroll arrow is located at each end of a scroll bar. To scroll through, or display different portions of the document in the document window, you can click a scroll arrow or drag the scroll box.

Status Bar  The status bar, located at the bottom of the document window above the Windows taskbar, presents information about the document, the progress of current tasks, and the status of certain commands and keys; it also provides controls for viewing the document. As you type text or perform certain commands, various indicators may appear on the status bar.

The left edge of the status bar in Figure 1–4 shows the current page followed by the total number of pages in the document, the number of words in the document, and a button to check spelling and grammar. Toward the right edge are buttons and controls you can use to change the view of a document and adjust the size of the displayed document.

Ribbon  The Ribbon, located near the top of the Word window, is the control center in Word (Figure 1–5a). The Ribbon provides easy, central access to the tasks you perform while creating a document. The Ribbon consists of tabs, groups, and commands. Each tab surrounds a collection of groups, and each group contains related commands.

When you start Word, the Ribbon displays seven top-level tabs: Home, Insert, Page Layout, References, Mailings, Review, and View. The Home tab, called the primary tab, contains the more frequently used commands. To display a different tab on the Ribbon, click the top-level tab. That is, to display the Insert tab, click Insert on the Ribbon. To return to the Home tab, click Home on the Ribbon. The tab currently displayed is called the active tab.

To display more of the document in the document window, some users prefer to minimize the Ribbon, which hides the groups on the Ribbon and displays only the top-level tabs (Figure 1–5b). To use commands on a minimized Ribbon, click the top-level tab.
Each time you start Word, the Ribbon appears the same way it did the last time you used Word. The chapters in this book, however, begin with the Ribbon appearing as it did at the initial installation of the software. If you are stepping through this chapter on a computer and you want your Ribbon to match the figures in this book, read Appendix E.

In addition to the top-level tabs, Word displays other tabs, called contextual tabs, when you perform certain tasks or work with objects such as pictures or tables. If you insert a picture in the document, for example, the Picture Tools tab and its related subordinate Format tab appear (Figure 1–6). When you are finished working with the picture, the Picture Tools and Format tabs disappear from the Ribbon. Word determines when contextual tabs should appear and disappear based on tasks you perform. Some contextual tabs, such as the Table Tools tab, have more than one related subordinate tab.

![Figure 1–6](image)

Commands on the Ribbon include buttons, boxes (text boxes, check boxes, etc.), and galleries (Figure 1–6). A gallery is a set of choices, often graphical, arranged in a grid or in a list. You can scroll through choices on an in-Ribbon gallery by clicking the gallery's scroll arrows. Or, you can click a gallery's More button to view more gallery options on the screen at a time. Some buttons and boxes have arrows that, when clicked, also display a gallery; others always cause a gallery to be displayed when clicked. Most galleries support live preview, which is a feature that allows you to point to a gallery choice and see its effect in the document — without actually selecting the choice (Figure 1–7).

![Figure 1–7](image)
Some commands on the Ribbon display an image to help you remember their function. When you point to a command on the Ribbon, all or part of the command glows in shades of yellow and orange, and an Enhanced ScreenTip appears on the screen. An Enhanced ScreenTip is an on-screen note that provides the name of the command, available keyboard shortcut(s), a description of the command, and sometimes instructions for how to obtain help about the command (Figure 1–8). Enhanced ScreenTips are more detailed than a typical ScreenTip, which usually only displays the name of the command.

The lower-right corner of some groups on the Ribbon has a small arrow, called a Dialog Box Launcher, that when clicked, displays a dialog box or a task pane with additional options for the group (Figure 1–9). When presented with a dialog box, you make selections and must close the dialog box before returning to the document. A task pane, by contrast, is a window that can remain open and visible while you work in the document.

Mini Toolbar and Shortcut Menus

The Mini toolbar, which appears automatically based on tasks you perform, contains commands related to changing the appearance of text in a document. All commands on the Mini toolbar also exist on the Ribbon. The purpose of the Mini toolbar is to minimize mouse movement. For example, if you want to use a command that currently is not displayed on the active tab, you can use the command on the Mini toolbar — instead of switching to a different tab to use the command.
When the Mini toolbar appears, it initially is transparent (Figure 1–10a). If you do not use the transparent Mini toolbar, it disappears from the screen. To use the Mini toolbar, move the mouse pointer into the toolbar, which causes the Mini toolbar to change from a transparent to bright appearance (Figure 1–10b).

A shortcut menu, which appears when you right-click an object, is a list of frequently used commands that relate to the right-clicked object. When you right-click a scroll bar, for example, a shortcut menu appears with commands related to the scroll bar. If you right-click an item in the document window, Word displays both the Mini toolbar and a shortcut menu (Figure 1–11).

**Quick Access Toolbar**

The Quick Access Toolbar, located by default above the Ribbon, provides easy access to frequently used commands (Figure 1–12a). The commands on the Quick Access Toolbar always are available, regardless of the task you are performing. Initially, the Quick Access Toolbar contains the Save, Undo, and Redo commands. If you click the Customize Quick Access Toolbar button, Word provides a list of commands you quickly can add to and remove from the Quick Access Toolbar (Figure 1–12b).
You also can add other commands to or delete commands from the Quick Access Toolbar so that it contains the commands you use most often. As you add commands to the Quick Access Toolbar, its commands may interfere with the document title on the title bar. For this reason, Word provides an option of displaying the Quick Access Toolbar below the Ribbon (Figure 1–13).

Each time you start Word, the Quick Access Toolbar appears the same way it did the last time you used Word. The chapters in this book, however, begin with the Quick Access Toolbar appearing as it did at the initial installation of the software. If you are stepping through this chapter on a computer and you want your Quick Access Toolbar to match the figures in this book, you should reset your Quick Access Toolbar. For more information about how to reset the Quick Access Toolbar, read Appendix E.

Office Button

While the Ribbon is a control center for creating documents, the Office Button is a central location for managing and sharing documents. When you click the Office Button, located in the upper-left corner of the window, Word displays the Office Button menu (Figure 1–14a). A menu contains a list of commands.

When you click the New, Open, Save As, and Print commands on the Office Button menu, Word displays a dialog box with additional options. The Save As, Print, Prepare, Send, and Publish commands have an arrow to their right. If you point to this arrow, Word displays a submenu, which is a list of additional commands associated with the selected command (Figure 1–14b). For the Prepare, Send, and Publish commands that do not display a dialog box when clicked, you can point either to the command or the arrow to display the submenu.
Key Tips

If you prefer using the keyboard instead of the mouse, you can press the ALT key on the keyboard to display a Key Tip badge, or keyboard code icon, for certain commands (Figure 1–15). To select a command using the keyboard, press its displayed code letter, or Key Tip. When you press a Key Tip, additional Key Tips related to the selected command may appear. For example, to select the New command on the Office Button menu, press the ALT key, then press the F key, and then press the N key.

To remove the Key Tip badges from the screen, press the ALT key or the ESC key until all Key Tip badges disappear, or click the mouse anywhere in the Word window.

Figure 1–15

Entering Text

The first step in creating a document is to enter its text by typing on the keyboard. By default, Word positions text you type at the left margin. In a later section of this chapter, you will learn how to format, or change the appearance of, the entered text.

Plan Ahead

Choose the words for the text.
The text in a flyer is organized into three areas: headline, body copy, and signature line.

- The headline is the first line of text on the flyer. It conveys the product or service being offered, such as a car for sale or personal lessons, or the benefit that will be gained, such as a convenience, better performance, greater security, higher earnings, or more comfort.
- The body text consists of all text between the headline and the signature line. This text highlights the key points of the message in as few words as possible. It should be easy to read and follow. While emphasizing the positive, the body text must be realistic, truthful, and believable.
- The signature line, which is the last line of text on the flyer, contains contact information or identifies a call to action.

Zooming

If text is too small for you to read on the screen, you can zoom the document by dragging the Zoom slider on the status bar or clicking the Zoom Out or Zoom In buttons on the status bar. Changing the zoom has no effect on the printed document.
To Type Text

To begin creating the flyer in this chapter, you type the headline in the document window. The following steps type this first line of text in the document.

1. Type Learn to Ride as the headline (Figure 1–16).

What if I make an error while typing?
You can press the BACKSPACE key until you have deleted the text in error and then retype the text correctly.

Why did the Spelling and Grammar Check icon appear on the status bar?
When you begin typing text, the Spelling and Grammar Check icon appears on the status bar with an animated pencil writing on paper that indicates Word is checking for spelling and grammar errors. When you stop typing, the pencil changes to a blue check mark (no errors) or a red X (potential errors found). Word flags potential errors in the document with a red or green wavy underline. Later, this chapter shows how to fix flagged errors.

2. Press the ENTER key to move the insertion point to the beginning of the next line (Figure 1–17).

Why did blank space appear between the headline and the insertion point?
Each time you press the ENTER key, Word creates a new paragraph and inserts blank space between the two paragraphs. Later in this chapter, you will learn how to adjust the spacing between paragraphs.
To Display Formatting Marks

To indicate where in a document you press the ENTER key or SPACEBAR, you may find it helpful to display formatting marks. A **formatting mark**, sometimes called a **nonprinting character**, is a character that Word displays on the screen but is not visible on a printed document. For example, the paragraph mark (¶) is a formatting mark that indicates where you pressed the ENTER key. A raised dot (·) shows where you pressed the SPACEBAR. Other formatting marks are discussed as they appear on the screen.

Depending on settings made during previous Word sessions, your Word screen already may display formatting marks (Figure 1–18). The following step displays formatting marks, if they do not show already on the screen.

1. If necessary, click Home on the Ribbon to display the Home tab.
2. If it is not selected already, click the Show/Hide ¶ button on the Home tab to display formatting marks on the screen (Figure 1–18).

What if I do not want formatting marks to show on the screen?

If you feel the formatting marks clutter the screen, you can hide them by clicking the Show/Hide ¶ button again. It is recommended that you display formatting marks so that you visually can identify when you press the ENTER key, SPACEBAR, and other keys associated with nonprinting characters; therefore, the document windows presented in this book show the formatting marks.

**Other Ways**

1. Press CTRL+SHIFT+*  

---

**Wordwrap**

**Wordwrap** allows you to type words in a paragraph continually without pressing the ENTER key at the end of each line. When the insertion point reaches the right margin, Word automatically positions the insertion point at the beginning of the next line. As you type, if a word extends beyond the right margin, Word also automatically positions that word on the next line along with the insertion point.

Word creates a new paragraph each time you press the ENTER key. Thus, as you type text in the document window, do not press the ENTER key when the insertion point reaches the right margin. Instead, press the ENTER key only in these circumstances:

1. To insert blank lines in a document
2. To begin a new paragraph
3. To terminate a short line of text and advance to the next line
4. To respond to questions or prompts in Word dialog boxes, task panes, and other on-screen objects
To Wordwrap Text as You Type

The next step in creating the flyer is to type the body copy. The following step wordwraps the text in the body copy.

1. Type High-quality Western and English riding lessons, focusing on safety and including instruction on horse care, saddling a horse, and other aspects of horsemanship.

Q&A

Why does my document wrap on different words?

Differences in wordwrap relate to the printer used by your computer. That is, the printer controls where wordwrap occurs for each line in your document. Thus, it is possible that the same document could wordwrap differently if printed on different printers.

1. Press the ENTER key to position the insertion point on the next line in the document (Figure 1–19).

To Insert a Blank Line

In the flyer, the picture of the horse and rider should be positioned below the paragraph just entered. The picture will be inserted after all text is entered and formatted. Thus, you will leave a blank line in the document for the picture. To enter a blank line in a document, press the ENTER key without typing any text on the line. The following step inserts one blank line below the first paragraph of body copy.

1. Press the ENTER key to insert a blank line in the document (Figure 1–20).
Spelling and Grammar Check

As you type text in a document, Word checks your typing for possible spelling and grammar errors. If all of the words you have typed are in Word's dictionary and your grammar is correct, as mentioned earlier, the Spelling and Grammar Check icon on the status bar displays a blue check mark. Otherwise, the icon shows a red X. In this case, Word flags the potential error in the document window with a red or green wavy underline. A red wavy underline means the flagged text is not in Word's dictionary (because it is a proper name or misspelled). A green wavy underline indicates the text may be incorrect grammatically. Although you can check the entire document for spelling and grammar errors at once, you also can check these flagged errors as they appear on the screen.

To display a list of corrections for flagged text, right-click the flagged text. When you right-click a flagged word, for example, a list of suggested spelling corrections appears on the screen. A flagged word, however, is not necessarily misspelled. For example, many names, abbreviations, and specialized terms are not in Word’s main dictionary. In these cases, you tell Word to ignore the flagged word. As you type, Word also detects duplicate words while checking for spelling errors. For example, if your document contains the phrase, to the the store, Word places a red wavy underline below the second occurrence of the word, the.

To Check Spelling and Grammar as You Type

In the following steps, the word, instruction, has been misspelled intentionally as intrution to illustrate Word’s check spelling as you type feature. If you are doing this project on a computer, your flyer may contain other misspelled words, depending on the accuracy of your typing.

1. Type Novice to advanced intrution and then press the SPACEBAR (Figure 1–21).

What if Word does not flag my spelling and grammar errors with wavy underlines?

To verify that the check spelling and grammar as you type features are enabled, click the Office Button and then click the Word Options button. When the Word Options dialog box is displayed, click Proofing, and then ensure the ‘Check spelling as you type’ and ‘Mark grammar errors as you type’ check boxes have check marks. Also ensure the ‘Hide spelling errors in this document only’ and ‘Hide grammar errors in this document only’ check boxes do not have check marks. Click the OK button.

Q&A

Copyright 2008 Thomson Learning, Inc. All Rights Reserved.
May not be copied, scanned, or duplicated, in whole or in part.
Right-click the flagged word (intrusion, in this case) to display a shortcut menu that includes a list of suggested spelling corrections for the flagged word (Figure 1–22).

What if, when I right-click the misspelled word, my desired correction is not in the list on the shortcut menu?
You can click outside the shortcut menu to close the menu and then retype the correct word, or you can click Spelling on the shortcut menu to display the Spelling dialog box. Chapter 2 discusses the Spelling dialog box.

What if a flagged word actually is, for example, a proper name and spelled correctly?
Right-click it and then click Ignore All on the shortcut menu to instruct Word not to flag future occurrences of the same word.

Click instruction on the shortcut menu to replace the misspelled word in the document (intrution) with the word, instruction (Figure 1–23).

Other Ways
1. Click Spelling and Grammar Check icon on status bar, click correct word on shortcut menu
To Enter More Text

In the flyer, the text yet to be entered includes the remainder of the body copy, which will be formatted as a bulleted list, and the signature line. The following steps enter the remainder of text in the flyer.

1. Press the END key to move the insertion point to the end of the current line.
2. Type for children and adults and then press the ENTER key.
3. Type Indoor and outdoor arenas and then press the ENTER key.
4. Type $40 per hour for private lessons; $25 for group lessons and then press the ENTER key.
5. To complete the text in the flyer, type Call Tri-Valley Stables at 555-2030 today! (Figure 1–24).

Saving the Project

While you are creating a document, the computer stores it in memory. When you save a document, the computer places it on a storage medium such as a USB flash drive, CD, or hard disk. A saved document is referred to as a file. A file name is the name assigned to a file when it is saved.

It is important to save a document frequently for the following reasons:

• The document in memory will be lost if the computer is turned off or you lose electrical power while Word is open.
• If you run out of time before completing your project, you may finish your document at a future time without starting over.
Determine where to save the document.
When saving a document, you must decide which storage medium to use.

• If you always work on the same computer and have no need to transport your projects to a different location, then your computer’s hard disk will suffice as a storage location. It is a good idea, however, to save a backup copy of your projects on a separate medium in case the file becomes corrupted or the computer’s hard disk fails.

• If you plan to work on your projects in various locations or on multiple computers, then you should save your projects on a portable medium, such as a USB flash drive or CD. The projects in this book use a USB flash drive, which saves files quickly and reliably and can be reused. CDs are easily portable and serve as good backups for the final versions of projects because they generally can save files only one time.

To Save a Document
You have performed many tasks while creating this project and do not want to risk losing the work completed thus far. Accordingly, you should save the document. The following steps save a document on a USB flash drive using the file name, Horseback Riding Lessons Flyer.

1. With a USB flash drive connected to one of the computer’s USB ports, click the Save button on the Quick Access Toolbar to display the Save As dialog box (Figure 1–25).

Do I have to save to a USB flash drive?
No. You can save to any device or folder. A folder is a specific location on a storage medium. You can save to the default folder or a different folder. You also can create your own folders, which is explained later in this book.

Figure 1–25
2. Type Horseback Riding Lessons Flyer in the File name text box to change the file name. Do not press the ENTER key after typing the file name (Figure 1–26).

What characters can I use in a file name?

A file name can have a maximum of 255 characters, including spaces. The only invalid characters are the backslash (\), slash (/), colon (:), asterisk (*), question mark (?), quotation mark ("), less than symbol (<), greater than symbol (>), and vertical bar (|).

3. Click the Save in box arrow to display a list of available drives and folders (Figure 1–27).

Why is my list of files, folders, and drives arranged and named differently from those shown in the figure?

Your computer’s configuration determines how the list of files and folders is displayed and how drives are named. You can change the save location by clicking shortcuts on the My Places bar.

How do I save the file if I am not using a USB flash drive?

Use the same process, but be certain to select your device in the Save in list.
Click UDISK 2.0 (E:) in the Save in list to select the USB flash drive, Drive E in this case, as the new save location (Figure 1–28).

What if my USB flash drive has a different name or letter? It is very likely that your USB flash drive will have a different name and drive letter and be connected to a different port. Verify the device in your Save in list is correct.

Click the Save button in the Save As dialog box to save the document on the USB flash drive with the file name, Horseback Riding Lessons Flyer (Figure 1–29).

How do I know that the project is saved? While Word is saving your file, it briefly displays a message on the status bar indicating the amount of the file saved. In addition, your USB drive may have a light that flashes during the save process.

Other Ways
1. Click Office Button, click Save, type file name, select drive or folder, click Save button
2. Press CTRL+S or press SHIFT+F12, type file name, select drive or folder, click Save button
Formatting Paragraphs and Characters in a Document

With the text for the flyer entered, the next step is to format its paragraphs and characters. Paragraphs encompass the text from the first character in a paragraph up to and including a paragraph mark (¶). **Paragraph formatting** is the process of changing the appearance of a paragraph. For example, you can center or indent a paragraph. Characters include letters, numbers, punctuation marks, and symbols. **Character formatting** is the process of changing the way characters appear on the screen and in print. You use character formatting to emphasize certain words and improve readability of a document. For example, you can italicize or underline characters. Often, you apply both paragraph and character formatting to the same text. For example, you may center a paragraph (paragraph formatting) and bold some of the characters in a paragraph (character formatting).

Although you can format paragraphs and characters before you type, many Word users enter text first and then format the existing text. Figure 1–30a shows the flyer in this chapter before formatting its paragraphs and characters. Figure 1–30b shows the flyer after formatting. As you can see from the two figures, a document that is formatted is easier to read and looks more professional. The following pages discuss how to format the flyer so that it looks like Figure 1–30b.

![Unformatted Document](image)

![Formatted Document](image)

**Figure 1–30**
Fonts, Font Sizes, Styles, and Themes

Characters that appear on the screen are a specific shape and size. The **font**, or typeface, defines the appearance and shape of the letters, numbers, and special characters. In Word, the default font usually is Calibri (Figure 1–31 on the next page). You can leave characters in the default font or change them to a different font. **Font size** specifies the size of the characters and is determined by a measurement system called points. A single **point** is about 1/72 of one inch in height. The default font size in Word typically is 11 (Figure 1–31). A character with a font size of 11 is about 11/72 or a little less than 1/6 of one inch in height. You can increase or decrease the font size of characters in a document.

When you create a document, Word formats the text using a particular style. A **style** is a named group of formatting characteristics, including font and font size. The default style in Word is called the **Normal style**, which most likely uses 11-point Calibri font. If you do not specify a style for text you type, Word applies the Normal style to the text. In addition to the Normal style, Word has many other built-in, or predefined, styles that you can use to format text. You also can create your own styles. Styles make it easy to apply many formats at once to text. After you apply a style to text, you easily can modify the text to include additional formats. You also can modify the style.

To assist you with coordinating colors and fonts and other formats, Word uses document themes. A document **theme** is a set of unified formats for fonts, colors, and graphics. The default theme fonts are Cambria for headings and Calibri for body text (Figure 1–31). Word includes a variety of document themes. By changing the document theme, you quickly give your document a new look. You also can define your own document themes.

---

**Identify how to format various elements of the text.**

By formatting the characters and paragraphs in a document, you can improve its overall appearance. In a flyer, consider the following formatting suggestions.

- **Increase the font size of characters.** Flyers usually are posted on a bulletin board or in a window. Thus, the font size should be as large as possible so that passersby easily can read the flyer. To give the headline more impact, its font size should be larger than the font size of the text in the body copy. If possible, make the font size of the signature line larger than the body copy but smaller than the headline.

- **Change the font of characters.** Use fonts that are easy to read. Try to use only two different fonts in a flyer, for example, one for the headline and the other for all other text. Too many fonts can make the flyer visually confusing.

- **Change paragraph alignment.** The default alignment for paragraphs in a document is **left-aligned**, that is, flush at the left margin of the document with uneven right edges. Consider changing the alignment of some of the paragraphs to add interest and variety to the flyer.

- **Highlight key paragraphs with bullets.** A **bullet** is a dot or other symbol positioned at the beginning of a paragraph. Use bullets to highlight important paragraphs in a flyer.

- **Emphasize important words.** To call attention to certain words or lines, you can underline them, italicize them, or bold them. Use these formats sparingly, however, because overuse will minimize their effect and make the flyer look too busy.

- **Use color.** Use colors that complement each other and convey the meaning of the flyer. Vary colors in terms of hue and brightness. Headline colors, for example, can be bold and bright. Signature lines should stand out more than body copy but less than headlines. Keep in mind that too many colors can detract from the flyer and make it difficult to read.
To Apply Styles

In the flyer, you want the headline and the signature line to be emphasized more than the other text. Word provides heading styles designed to emphasize this type of text. The first step in formatting the flyer is to apply the Heading 1 style to the headline and the Heading 2 style to the signature line. The default Heading 1 style is a 14-point Cambria bold font. The default Heading 2 style is a 13-point Cambria bold font. The default theme color scheme uses shades of blue for headings.

To apply a style to a paragraph, you first position the insertion point in the paragraph and then apply the style. The following steps apply heading styles to paragraphs.

1. Press CTRL+HOME (that is, press and hold down the CTRL key, press the HOME key, and then release both keys) to position the insertion point at the top of the document (Figure 1–31).

2. Point to Heading 1 in the Styles gallery to display a live preview in the document of the Heading 1 style (Figure 1–32).

Q&A

What happens if I move the mouse pointer?

If you move the mouse pointer away from the gallery, the text containing the insertion point returns to the Normal style.
3. Click Heading 1 in the Styles gallery to apply the Heading 1 style to the headline (Figure 1–33).

Why did a square appear on the screen near the left edge of the headline?
The square is a nonprinting character, like the paragraph mark, that indicates text to its right has been formatted using a style.

4. Press CTRL+END (that is, press and hold down the CTRL key, press the END key, and then release both keys) to position the insertion point at the end of the document.

• Click Heading 2 in the Styles gallery to apply the Heading 2 style to the signature line (Figure 1–34).

Other Ways
1. Click Styles Dialog Box Launcher, click desired style in Styles task pane
2. Press CTRL+SHIFT+S, click Style Name box arrow in Apply Styles task pane, click desired style in list
To Center a Paragraph

The headline in the flyer currently is left-aligned (Figure 1–35). You want the headline to be centered, that is, positioned horizontally between the left and right margins on the page. Thus, you will center the paragraph containing the headline. Recall that Word considers a single short line of text, such as the three-word headline, a paragraph. The following steps center a paragraph.

1. Click somewhere in the paragraph to be centered (in this case, the headline) to position the insertion point in the paragraph to be formatted (Figure 1–35).

2. Click the Center button on the Home tab to center the headline (Figure 1–36).

What if I want to return the paragraph to left-aligned?

Click the Align Text Left button on the Home tab.

Other Ways

1. Right-click paragraph, click Center button on Mini toolbar
2. Right-click paragraph, click Paragraph on shortcut menu, click Indents and Spacing tab, click Alignment box arrow, click Centered, click OK button
3. Click Paragraph Dialog Box Launcher, click Indents and Spacing tab, click Alignment box arrow, click Centered, click OK button
4. Press CTRL+E

Formatting Single Versus Multiple Paragraphs and Characters

As shown in the previous pages, to format a single paragraph, simply move the insertion point in the paragraph and then format the paragraph. Likewise, to format a single word, position the insertion point in the word and then format the word.
To format multiple paragraphs or words, however, you first must select the paragraphs or words you want to format and then format the selection. If your screen normally displays dark letters on a light background, which is the default setting in Word, then selected text displays light letters on a dark background.

**To Select a Line**

The font size of characters in the Heading 1 style, 14 point, is too small for passersby to read in the headline of the flyer. To increase the font size of the characters in the headline, you must first select the line of text containing the headline. The following steps select a line.

1. Move the mouse pointer to the left of the line to be selected (in this case, the headline) until the mouse pointer changes to a right-pointing block arrow (Figure 1–37).

2. While the mouse pointer is a right-pointing block arrow, click the mouse to select the entire line to the right of the mouse pointer (Figure 1–38).

---

**Other Ways**

1. Drag mouse through line
2. With insertion point at beginning of desired line, press SHIFT+DOWN ARROW
To Change the Font Size of Selected Text

The next step is to increase the font size of the characters in the selected headline. You would like the headline to be as large as possible and still fit on a single line, which in this case is 48 point. The following steps increase the font size of the headline from 14 to 48 point.

1. With the text selected, click the Font Size box arrow on the Home tab to display the Font Size gallery (Figure 1–39).

Why are the font sizes in my Font Size gallery different from those in Figure 1–39?

Font sizes may vary depending on the current font and your printer driver.

What happened to the Mini toolbar?

The Mini toolbar disappears if you do not use it. These steps used the Font Size box arrow on the Home tab instead of the Font Size box arrow on the Mini toolbar. If a command exists both on the currently displayed tab and the Mini toolbar, this book uses the command on the tab. When the command is not on the currently displayed tab, the Mini toolbar is used.

2. Point to 48 in the Font Size gallery to display a live preview of the headline at 48 point (Figure 1–40).

Experiment

Point to various font sizes in the Font Size gallery and watch the font size of the headline change in the document window.

3. Click 48 in the Font Size gallery to increase the font size of the selected text to 48.
To Change the Font of Selected Text

As mentioned earlier, the default Heading 1 style uses the font called Cambria. Word, however, provides many other fonts to add variety to your documents. To draw more attention to the headline, you change its font so it differs from the font of other text in the flyer. The following steps change the font from Cambria to Copperplate Gothic Bold.

1. With the text selected, click the Font box arrow on the Home tab to display the Font gallery (Figure 1–41).

Will the fonts in my Font gallery be the same as those in Figure 1–41?
Your list of available fonts may differ, depending on the type of printer you are using.

2. Scroll through the Font gallery, if necessary, and then point to Copperplate Gothic Bold (or a similar font) to display a live preview of the headline in Copperplate Gothic Bold font (Figure 1–42).

Experiment
Point to various fonts in the Font gallery and watch the font of the headline change in the document window.

3. Click Copperplate Gothic Bold (or a similar font) to change the font of the selected text to Copperplate Gothic Bold.

Other Ways

1. Click Font box arrow on Mini toolbar, click desired font in Font gallery
2. Right-click selected text, click Font on shortcut menu, click Font tab, select desired font in Font list, click OK button
3. Click Font Dialog Box Launcher, click Font tab, select desired font in Font list, click OK button
4. Press CTRL+SHIFT+F, click Font tab, select desired font in Font list, click OK button
To Select Multiple Paragraphs

The next formatting step in creating the flyer is to increase the font size of the characters between the headline and the signature line so that they are easier to read from a distance. To change the font size of the characters in multiple lines, you first must select all the lines to be formatted. The following steps select multiple lines.

1. Move the mouse pointer to the left of the first paragraph to be selected until the mouse pointer changes to a right-pointing block arrow (Figure 1–43).

2. Drag downward to select all lines that will be formatted (Figure 1–44).

How do I drag the mouse?

Dragging is the process of holding down the mouse button while moving the mouse and then releasing the mouse button.

Other Ways

1. With insertion point at beginning of desired line, press SHIFT+DOWN ARROW repeatedly until all lines are selected.

Copyright 2008 Thomson Learning, Inc. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.
To Change the Font Size of Selected Text

The characters between the headline and the signature line in the flyer currently are 11 point. To make them easier to read from a distance, this flyer uses 16 point for these characters. The following steps change the font size of the selected text.

1. With the text selected, click the Font Size box arrow on the Home tab to display the Font Size gallery.
2. Click 16 in the Font Size gallery to increase the font size of the selected text to 16.

To Format a Line

In the flyer, the signature line is to be centered to match the paragraph alignment of the headline. Also, its text should have a font size larger than the rest of the body copy. The following steps center the line and increase its font size to 18.

1. Click somewhere in the paragraph to be centered (in this case, the signature line) to position the insertion point in the paragraph to be formatted.
2. Click the Center button on the Home tab to center the signature line.
3. Move the mouse pointer to the left of the line to be selected (in this case, the signature line) until the mouse pointer changes to a right-pointing block arrow and then click to select the line.
4. With the signature line selected, click the Font Size box arrow on the Home tab and then click 18 in the Font Size gallery to increase the font size of the selected text to 18 (Figure 1–45).

Figure 1–45
To Bullet a List of Paragraphs

The next step is to format the three important points above the signature line in the flyer as a bulleted list. A **bulleted list** is a series of paragraphs, each beginning with a bullet character. The three lines each end with a paragraph mark because you pressed the ENTER key at the end of each line. Thus, these three lines actually are three separate paragraphs.

To format a list of paragraphs with bullets, you first must select all the lines in the paragraphs. The following steps bullet a list of paragraphs.

1. **Move the mouse pointer to the left of the first paragraph to be selected until the mouse pointer changes to a right-pointing block arrow.**

2. **Drag downward until all paragraphs (lines) that will be formatted with a bullet character are selected.**

How do I remove bullets from a list or paragraph?

Select the list or paragraph and click the Bullets button again.

Other Ways

| 1. Right-click selected paragraphs, click Bullets button on Mini toolbar |
| 2. Right-click selected paragraphs, point to Bullets on shortcut menu, click desired bullet style |

To Undo and Redo an Action

Word provides a means of canceling your recent command(s) or action(s). For example, if you format text incorrectly, you can undo the format and try it again. When you point to the Undo button, Word displays the action you can undo as part of the ScreenTip.

If, after you undo an action, you decide you did not want to perform the undo, you can redo the undone action. Word does not allow you to undo or redo some actions, such as saving or printing a document. The next steps undo the bullet format just applied and then redo the bullet format.
To Select a Group of Words

To emphasize the types of riding lessons, Western and English, these words are bold in the flyer. To format a group of words, you first must select them. The following steps select a group of words.

1. Position the mouse pointer immediately to the left of the first character of the text to be selected, in this case, the W in Western (Figure 1–48).

Q&A
Why did the shape of the mouse pointer change?
The mouse pointer’s shape is an I-beam when positioned in unselected text in the document window.

Copyright 2008 Thomson Learning, Inc. All Rights Reserved.
May not be copied, scanned, or duplicated, in whole or in part.
• Drag the mouse pointer through the last character of the text to be selected, in this case, the h in English (Figure 1–49).

Why did the mouse pointer shape change again?
When the mouse pointer is positioned in selected text, its shape is a left-pointing block arrow.

**Q&A**

**To Bold Text**

**Bold** characters display somewhat thicker and darker than those that are not bold. The following step formats the selected words, Western and English, as bold.

1. With the text selected, click the Bold button on the Home tab to format the selected text in bold (Figure 1–50).

How would I remove a bold format?
You would click the Bold button a second time, or you immediately could click the Undo button on the Quick Access Toolbar.

**Other Ways**

1. With insertion point at beginning of first word in group, press CTRL+SHIFT+RIGHT ARROW repeatedly until all words are selected
2. Click Bold button on Mini toolbar
3. Right-click selected text, click Font on shortcut menu, click Font tab, click Bold in Font style list, click OK button
4. Press CTRL+B

Figure 1–49

Figure 1–50
To Underline a Word

As with bold text, underlines are used to emphasize or draw attention to specific text. Underlined text prints with an underscore (_) below each character. In the flyer, the word, and, in the first bulleted paragraph is emphasized with an underline.

As with a single paragraph, if you want to format a single word, you do not need to select the word. Simply position the insertion point somewhere in the word and apply the desired format. The following step formats a word with an underline.

1. Click somewhere in the word to be underlined (and, in this case).
2. Click the Underline button on the Home tab to underline the word containing the insertion point (Figure 1–51).

How would I remove an underline?
You would click the Underline button a second time, or you immediately could click the Undo button on the Quick Access Toolbar.

Q&A

Are other types of underlines available?
In addition to the basic solid underline shown in Figure 1–51, Word has many decorative underlines, such as double underlines, dotted underlines, and wavy underlines. You can access the decorative underlines and also change the color of an underline through the Underline gallery.

Copyright 2008 Thomson Learning, Inc. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.
To Italicize Text

To further emphasize the signature line, this line is italicized in the flyer. **Italicized** text has a slanted appearance. The following steps select the text and then italicize it.

1. **Point to the left of the line to be selected (in this case, the signature line) and click when the mouse pointer is a right-pointing block arrow.**

2. **Click the Italic button on the Home tab to italicize the selected text.**

3. **Click inside the selected text to remove the selection (Figure 1–52).**

   How would I remove an italic format?
   You would click the Italic button a second time, or you immediately could click the Undo button on the Quick Access Toolbar.

   How can I tell what formatting has been applied to text?
   The selected buttons and boxes on the Home tab show formatting characteristics of the location of the insertion point. With the insertion point in the signature line, the Home tab shows these formats: 18-point Cambria bold italic font, centered paragraph, and Heading 2 style.

Other Ways

1. Click Italic button on Mini toolbar
2. Right-click selected text, click Font on shortcut menu, click Font tab, click Italic in Font style list, click OK button
3. Click Font Dialog Box Launcher, click Font tab, click Italic in Font style list, click OK button
4. Press CTRL+I

---

**Document Formats**

One advantage of using styles to format text is that you easily can change the formats of styles and themes in your document to give it a different or new look. Recall that a style is a named group of formatting characteristics and a theme is a set of unified formats for fonts, colors, and graphics. In Word, you can change the style set, theme colors, and theme fonts.

- The predefined styles in the Styles gallery, such as Heading 1 and Heading 2, each known as a **Quick Style**, are part of a style set. A **style set** consists of a group of frequently used styles formatted so they look pleasing when used together. When you change the style set, formats assigned to each Quick Style also change.
To Change the Style Set

To symbolize perfection and precision in the flyer, the characters in the headline are white. The style set, called Modern, formats Heading 1 characters in white. It also formats the Heading 1 and Heading 2 styles in all capital letters and places a background color around the paragraphs, which further emphasize the headline and signature line in the flyer. Thus, you will change the style set from Default to Modern. The following steps change a style set.

1. Click the Change Styles button on the Home tab to display the Change Styles menu (Figure 1–53).

To Change the Style Set

To symbolize perfection and precision in the flyer, the characters in the headline are white. The style set, called Modern, formats Heading 1 characters in white. It also formats the Heading 1 and Heading 2 styles in all capital letters and places a background color around the paragraphs, which further emphasize the headline and signature line in the flyer. Thus, you will change the style set from Default to Modern. The following steps change a style set.

1. Click the Change Styles button on the Home tab to display the Change Styles menu (Figure 1–53).

Copyright 2008 Thomson Learning, Inc. All Rights Reserved.
May not be copied, scanned, or duplicated, in whole or in part.
2. Point to Style Set on the Change Styles menu to display the Style Set gallery.

3. Point to Modern in the Style Set gallery to display a live preview of the formats associated with the Modern style set (Figure 1–54).

Experiment

Point to various style sets in the Style Set gallery and watch the formats of the styled text change in the document window.

3. Click Modern in the Style Set gallery to change the document style set to Modern.

What if I want to return to the original style set?

You would click the Change Styles button, click Style Set on the Change Styles menu, and then click Default in the Style Set gallery, or you could click the Undo button on the Quick Access Toolbar.

Style Formats

To see the formats assigned to a particular style in a document, click the Styles Dialog Box Launcher on the Home tab and then click the Style Inspector button in the Styles task pane. Position the insertion point in the style and then point to the Paragraph formatting or Text level formatting areas in the Style Inspector task pane to display an Enhanced ScreenTip describing formats assigned to the location of the insertion point. You also can click the Reveal Formatting button in the Style Inspector to display the Reveal Formatting task pane.
To Change Theme Colors

To suggest enthusiasm, success, and honesty, the background colors around the headline and signature line paragraphs in the flyer use shades of orange and brown. In Word, the color scheme called Aspect uses these colors. Thus, you will change the color scheme to Aspect. The following steps change theme colors.

1. Click the Change Styles button on the Home tab to display the Change Styles menu.
2. Point to Colors on the Change Styles menu to display the Colors gallery.
3. Point to Aspect in the Colors gallery to display a live preview of the Aspect color scheme (Figure 1–55).

Experiment

Point to various color schemes in the Colors gallery and watch the paragraph background colors change in the document window.

To Change Theme Fonts

Earlier in this chapter, you changed the font of the headline to Copperplate Gothic Bold. In this flyer, all text below the headline should be the Rockwell font, instead of the Calibri font, because it better matches the western tone of the flyer. Thus, the next step is to change the current font set, which is called Office, to a font set called Foundry, which uses the Rockwell font for headings and body text.
If you previously changed a font using buttons on the Ribbon or Mini toolbar, Word will not alter those when you change the font set because changes to the font set are not applied to fonts changed individually. This means the font headline in the flyer will stay as Copperplate Gothic Bold when you change the font set. The following steps change the font set to Foundry.

1. Click the Change Styles button on the Home tab.
2. Point to Fonts on the Change Styles menu to display the Fonts gallery.
3. Scroll through the Fonts gallery until Foundry is displayed and then point to Foundry to display a live preview of the Foundry font set (Figure 1–56).

Experiment
- Point to various font sets in the Fonts gallery and watch the fonts below the headline change in the document window.

![](change_styles.png)

**Figure 1–56**

Inserting and Formatting a Picture in a Word Document

With the text formatted in the flyer, the next step is to insert a picture in the flyer and format the picture. Flyers usually contain graphical images, such as a picture, to attract the attention of passersby.
Find the appropriate graphical image.

To use graphical images, also called graphics, in a Word document, the image must be stored digitally in a file. Files containing graphical images are available from a variety of sources:

- Word includes a collection of predefined graphical images that you can insert in a document.
- Microsoft has free digital images on the Web for use in a document. Other Web sites also have images available, some of which are free, while others require a fee.
- You can take a picture with a digital camera and download it, which is the process of copying the digital picture from the camera to your computer.
- With a scanner, you can convert a printed picture, drawing, or diagram to a digital file.

If you receive a picture from a source other than yourself, do not use the file until you are certain it does not contain a virus. A virus is a computer program that can damage files and programs on your computer. Use an antivirus program to verify that any files you use are virus free.

Establish where to position and how to format the graphical image.

The content, size, shape, position, and format of a graphic should capture the interest of passersby, enticing them to stop and read the flyer. Often, the graphic is the center of attraction and visually the largest element on a flyer. If you use colors in the graphical image, be sure they are part of the document’s color scheme.

To Insert a Picture

The next step in creating the flyer is to insert the picture of the horse and rider so that it is centered on the blank line above the bulleted list. The picture, which was taken with a digital camera, is available on the Data Files for Students. See the inside back cover of this book for instructions on downloading the Data Files for Students, or contact your instructor for information on accessing the required files. The following steps insert a centered picture, which, in this example, is located on the same USB flash drive that contains the saved flyer.

1. To position the insertion point where you want the picture to be located, press CTRL+HOME and then press the DOWN ARROW key four times.

2. Click the Center button on the Home tab to center the paragraph that will contain the picture.

3. Click Insert on the Ribbon to display the Insert tab (Figure 1–57).
2. Click the Insert Picture from File button on the Insert tab to display the Insert Picture dialog box.

With your USB flash drive connected to one of the computer’s USB ports, if necessary, click the Look in box arrow and then click UDISK 2.0 (E:) to select the USB flash drive, Drive E in this case, in the Look in list as the device that contains the picture.

Click Horse and Rider to select the file name (Figure 1–58).

What if the picture is not on a USB flash drive?

Use the same process, but be certain to select the device containing the picture in the Look in list.

3. Click the Insert button in the dialog box to insert the picture at the location of the insertion point in the document (Figure 1–59).

What are the symbols around the picture?

A selected graphic appears surrounded by a selection rectangle, which has small squares and circles, called sizing handles, at each corner and middle location.
Scrolling

As mentioned at the beginning of this chapter, you view only a portion of a document on the screen through the document window. At some point when you type text or insert graphics, Word will scroll the top or bottom portion of the document off the screen. Although you cannot see the text and graphics once they scroll off the screen, they remain in the document.

As shown in Figure 1–59, when you insert the picture in the flyer, the text and graphics are too long to fit in the document window. Thus, to see the bottom of the flyer, you will need to scroll downward.

You may use either the mouse or the keyboard to scroll to a different location in a document. With the mouse, you can use the scroll arrows or the scroll box on the scroll bar to display a different portion of the document in the document window, and then click the mouse to move the insertion point to that location. Table 1–1 explains various techniques for using the scroll bar to scroll vertically with the mouse.

<table>
<thead>
<tr>
<th>SCROLL DIRECTION</th>
<th>MOUSE ACTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Drag the scroll box upward.</td>
</tr>
<tr>
<td>Down</td>
<td>Drag the scroll box downward.</td>
</tr>
<tr>
<td>Up one screen</td>
<td>Click anywhere above the scroll box on the vertical scroll bar.</td>
</tr>
<tr>
<td>Down one screen</td>
<td>Click anywhere below the scroll box on the vertical scroll bar.</td>
</tr>
<tr>
<td>Up one line</td>
<td>Click the scroll arrow at the top of the vertical scroll bar.</td>
</tr>
<tr>
<td>Down one line</td>
<td>Click the scroll arrow at the bottom of the vertical scroll bar.</td>
</tr>
</tbody>
</table>

When you use the keyboard to scroll, the insertion point automatically moves when you press the appropriate keys. Table 1–2 outlines various techniques to scroll through a document using the keyboard, some of which you have seen used in this chapter.

<table>
<thead>
<tr>
<th>SCROLL DIRECTION</th>
<th>KEY(S) TO PRESS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left one character</td>
<td>LEFT ARROW</td>
</tr>
<tr>
<td>Right one character</td>
<td>RIGHT ARROW</td>
</tr>
<tr>
<td>Left one word</td>
<td>CTRL+LEFT ARROW</td>
</tr>
<tr>
<td>Right one word</td>
<td>CTRL+RIGHT ARROW</td>
</tr>
<tr>
<td>Up one line</td>
<td>UP ARROW</td>
</tr>
<tr>
<td>Down one line</td>
<td>DOWN ARROW</td>
</tr>
<tr>
<td>To end of line</td>
<td>END</td>
</tr>
<tr>
<td>To beginning of line</td>
<td>HOME</td>
</tr>
<tr>
<td>Up one paragraph</td>
<td>CTRL+UP ARROW</td>
</tr>
<tr>
<td>Down one paragraph</td>
<td>CTRL+DOWN ARROW</td>
</tr>
<tr>
<td>Up one screen</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Down one screen</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>To top of document window</td>
<td>ALT+CTRL+PAGE UP</td>
</tr>
<tr>
<td>To bottom of document window</td>
<td>ALT+CTRL+PAGE DOWN</td>
</tr>
<tr>
<td>To beginning of document</td>
<td>CTRL+HOME</td>
</tr>
<tr>
<td>To end of document</td>
<td>CTRL+END</td>
</tr>
</tbody>
</table>

Minimize Wrist Injury

Computer users frequently switch between the keyboard and the mouse during a word processing session; such switching strains the wrist. To help prevent wrist injury, minimize switching. For instance, if your fingers already are on the keyboard, use keyboard keys to scroll. If your hand already is on the mouse, use the mouse to scroll.
To Apply a Picture Style

Earlier in this chapter, you applied the heading styles to the headline and signature line in the flyer. Word also provides styles for pictures, allowing you easily to change the basic rectangle format to a more visually appealing style. Word provides a gallery of more than 25 picture styles, which include a variety of shapes, angles, borders, and reflections. The flyer in this chapter uses an oval picture style that has a border around its edges. The following steps apply a picture style to the picture in the flyer.

1. Click the down scroll arrow on the vertical scroll bar as many times as necessary until the entire picture is displayed in the document window (Figure 1–60).

What if the Picture Tools and Format tabs no longer are displayed on my Ribbon?
Double-click the picture to display the Picture Tools and Format tabs.

Q&A

2. Click the More button in the Picture Styles gallery, which shows more gallery options.

• Point to Metal Oval in the Picture Styles gallery to display a live preview of that style applied to the picture in the document (Figure 1–61).

Experiment

• Point to various picture styles in the Picture Styles gallery and watch the format of the picture change in the document window.

3. Click Metal Oval in the Picture Styles gallery to apply the selected style to the picture.
**To Change a Picture Border Color**

The flyer in this chapter has a tan border around the picture. Earlier in this chapter, you changed the color scheme to Aspect. To coordinate the border color with the other colors in the document, you will use a shade of tan in Aspect color scheme for the picture border. Any color galleries you display show colors defined in this current color scheme. The following steps change the picture border color.

1. Click the Picture Border button on the Format tab to display the Picture Border gallery.

2. Point to Tan, Background 2 (third theme color from left in the first row) in the Picture Border gallery to display a live preview of that border color on the picture (Figure 1–62).

**Experiment**

- Point to various colors in the Picture Border gallery and watch the border color on the picture change in the document window.

- Click Tan, Background 2 in the Picture Styles gallery to change the picture border color.

**To Zoom the Document**

The next step in formatting the picture is to resize it. Specifically, you will increase the size of the picture. You do not want it so large, however, that it causes the flyer text to flow to a second page. You can change the zoom so that you can see the entire document on the screen at once. Seeing the entire document at once helps you determine the appropriate size of the picture. The steps on the next page zoom the document.
1. Experiment

- Repeatedly click the Zoom Out and Zoom In buttons on the status bar and watch the size of the document change in the document window.

2. Click the Zoom Out or Zoom In button as many times as necessary until the Zoom level button displays 50% on its face (Figure 1–63).

If I change the zoom percentage, will the document print differently?

Changing the zoom has no effect on the printed document.

To Resize a Graphic

The next step is to resize the picture. Resizing includes both enlarging and reducing the size of a graphic. The picture in the flyer should be as large as possible, without causing any flyer text to flow to a second page.

With the entire document displaying in the document window, you will be able to see how the resized graphic will look on the entire page. The following steps resize a selected graphic.

1. With the graphic still selected, point to the upper-right corner sizing handle on the picture so that the mouse pointer shape changes to a two-headed arrow (Figure 1–64).

What if my graphic (picture) is not selected?

To select a graphic, click it.
Drag the sizing handle diagonally outward until the crosshair mouse pointer is positioned approximately as shown in Figure 1–65.

Release the mouse button to resize the graphic.

What if the graphic is the wrong size?
Repeat Steps 1 and 2.

Click outside the graphic to deselect it (Figure 1–66).

What happened to the Picture Tools and Format tabs?
When you click outside of a graphic or press a key to scroll through a document, Word deselects the graphic and removes the Picture Tools and Format tabs from the screen.

What if I want to return a graphic to its original size and start again?
With the graphic selected, click the Size Dialog Box Launcher on the Format tab to display the Size dialog box, click the Size tab, click the Reset button, and then click the Close button.
Enhancing the Page

With the text and graphics entered and formatted, the next step is to look at the page as a whole and determine if it looks finished in its current state. As you review the page, answer these questions:

- Does it need a page border to frame its contents, or would a page border make it look too busy?
- Is the spacing between paragraphs and graphics on the page adequate? Do any sections of text or graphics look as if they are positioned too closely to the items above or below them?

You determine that a graphical, color-coordinated border would enhance the flyer. You also notice that the flyer would look more proportionate if it had a little more space below the headline and above the graphic. The following pages make these enhancements to the flyer.

To Add a Page Border

In Word, you can add a border around the perimeter of an entire page. In this flyer, you add a graphical border that uses a shade of brown from the Aspect color scheme. The following steps add a graphical page border.

1. Click Page Layout on the Ribbon to display the Page Layout tab.
2. Click the Page Borders button on the Page Layout tab to display the Borders and Shading dialog box (Figure 1–67).
2. Click the Art box arrow to display the Art gallery.
   - Click the down scroll arrow in the Art gallery until the art border shown in Figure 1–68 appears.

3. Click the art border shown in Figure 1–68 to display a preview of the selection in the Preview area of the dialog box.
   - Click the Color box arrow to display a Color gallery (Figure 1–69).
   - Do I have to use an art border?
     No. You can select a solid or decorative line in the Style list.
   - Can I add color to every border type?
     You can color all of the line styles and many of the art borders.

4. Click the right-most theme color (Tan, Accent 6) in the Color gallery to display a preview of the selection in the Preview area.
   - Click the OK button to add the border to the page (Figure 1–70).
   - What if I wanted to remove the border?
     Click None in the Setting list in the Borders and Shading dialog box.
To Change Spacing Above and Below Paragraphs

The default spacing above a heading paragraph in Word is 10 points. In the flyer, you want to remove this spacing so the headline is closer to the page border. The default spacing below (after) a body text paragraph is 0 points. Below the first paragraph of body copy in the flyer, you want to increase this space. The following steps change the spacing above and below paragraphs.

1. Position the insertion point in the paragraph to be adjusted, in this case, the headline.
2. Click the Spacing Before box down arrow on the Page Layout tab as many times as necessary until 0 pt is displayed in the Spacing Before text box (Figure 1–71).

Why is a blank space still between the border and the headline? The space is a result of Word’s preset left, right, top, and bottom margins and other settings.

1. Position the insertion point in the paragraph below the headline.
2. Click the Spacing After box up arrow on the Page Layout tab as many times as necessary until 24 pt is displayed in the Spacing After text box, shown in Figure 1–72. (If the text flows to two pages, resize the picture so that it is smaller.)

To Zoom the Document

You are finished enhancing the page and no longer need to view the entire page in the document window. Thus, the following step changes the zoom back to 100 percent.

1. Click the Zoom In button as many times as necessary until the Zoom level button displays 100% on its face, shown in Figure 1–72.

Changing Document Properties and Saving Again

Word helps you organize and identify your files by using document properties, which are the details about a file. Document properties, also known as metadata, can include such information as the project author, title, or subject. Keywords are words or phrases that further describe the document. For example, a class name or document topic can describe the file’s purpose or content.
Document properties are valuable for a variety of reasons:

- Users can save time locating a particular file because they can view a document's properties without opening the document.
- By creating consistent properties for files having similar content, users can better organize their documents.
- Some organizations require Word users to add document properties so that other employees can view details about these files.

Five different types of document properties exist, but the more common ones used in this book are standard and automatically updated properties. **Standard properties** are associated with all Microsoft Office documents and include author, title, and subject. **Automatically updated properties** include file system properties, such as the date you create or change a file, and statistics, such as the file size.

**To Change Document Properties**

The **Document Information Panel** contains areas where you can view and enter document properties. You can view and change information in this panel at any time while you are creating a document. Before saving the flyer again, you want to add your name and course information as document properties. The following steps use the Document Information Panel to change document properties.

1. Click the **Office Button** to display the Office Button menu.
2. Point to **Prepare** on the Office Button menu to display the Prepare submenu (Figure 1–72).

What other types of actions besides changing properties can you take to prepare a document for distribution?

The **Prepare** submenu provides commands related to sharing a document with others, such as allowing or restricting people to view and modify your document, checking to see if your document will open in earlier versions of Word, and searching for hidden personal information.
Click Properties on the Prepare submenu to display the Document Information Panel (Figure 1–73).

Why are some of the document properties in my Document Information Panel already filled in? The person who installed Microsoft Office 2007 on your computer or network may have set or customized the properties.

Click the Author text box, if necessary, and then type your name as the Author property. If a name already is displayed in the Author text box, delete it before typing your name.

Click the Subject text box, if necessary delete any existing text, and then type your course and section as the Subject property.

Click the Keywords text box, if necessary delete any existing text, and then type Tri-Valley Stables as the Keywords property (Figure 1–74).

What types of document properties does Word collect automatically? Word records such details as how long you worked at creating your project, how many times you revised the document, and what fonts and themes are used.

Click the Close the Document Information Panel button so that the Document Information Panel no longer is displayed.
To Save an Existing Document with the Same File Name

Saving frequently cannot be overemphasized. You have made several modifications to the document since you saved it earlier in the chapter. When you first saved the document, you clicked the Save button on the Quick Access Toolbar, the Save As dialog box appeared, and you entered the file name, Horseback Riding Lessons Flyer. If you want to use the same file name to save the changes made to the document, you again click the Save button on the Quick Access Toolbar. The following step saves the document again.

1. Click the Save button on the Quick Access Toolbar to overwrite the previous Horseback Riding Lessons Flyer file on the USB flash drive (Figure 1–75).

Why did the Save As dialog box not appear?

Word overwrites the document using the settings specified the first time you saved the document. To save the file with a different file name or on different media, display the Save As dialog box by clicking the Office Button and then clicking Save As on the Office Button menu. Then, fill in the Save As dialog box as described in Steps 2 through 5 on pages WD 20 and WD 21.

Figure 1–75

Printing a Document

After you create a document, you often want to print it. A printed version of the document is called a hard copy or printout.

Printed copies of your document can be useful for the following reasons:

- Many people prefer proofreading a hard copy of the document rather than viewing it on the screen to check for errors and readability.
- Hard copies can serve as reference material if your storage medium is lost or becomes corrupted and you need to re-create the document.

It is a good practice to save a document before printing it, in the event you experience difficulties with the printer.

Conserving Ink and Toner

You can instruct Word to print draft quality documents to conserve ink or toner by clicking the Office Button, clicking the Word Options button, clicking Advanced in the left pane of the Word Options dialog box, scrolling to the Print area, placing a check mark in the ‘Use draft quality’ check box, and then clicking the OK button. To print the document with these settings, click the Office Button, point to Print, and then click Quick Print.
To Print a Document

With the completed document saved, you may want to print it. The following steps print the contents of the saved Horseback Riding Lessons Flyer project.

1. Click the Office Button to display the Office Button menu.
2. Point to Print on the Office Button menu to display the Print submenu (Figure 1–76).

1. Click Quick Print on the Print submenu to print the document.
2. When the printer stops, retrieve the hard copy of the Horseback Riding Lessons Flyer (Figures 1–77).

How can I print multiple copies of my document other than issuing the Quick Print command twice?
Click the Office Button, point to Print on the Office Button menu, click Print on the Print submenu, increase the number in the Number of copies box, and then click the OK button.

Do I have to wait until my document is complete to print it?
No, you can follow these steps to print a document at any time while you are creating it.

Other Ways

1. Press CTRL+P, press ENTER

Copyright 2008 Thomson Learning, Inc. All Rights Reserved.
May not be copied, scanned, or duplicated, in whole or in part.
Quitting Word

If you save a document and then quit Word, all Word windows close. If you have made changes to a document since the last time the file was saved, Word displays a dialog box asking if you want to save the changes you made to the file before it closes that window. The dialog box contains three buttons with these resulting actions:

- Yes button — Saves the changes and then quits Word
- No button — Quits Word without saving changes
- Cancel button — Closes the dialog box and redisplays the document without saving the changes

If no changes have been made to an open document since the last time the file was saved, Word will close all windows without displaying any dialog boxes.

To Quit Word

You saved the document prior to printing and did not make any changes to the project. The Horseback Riding Lessons Flyer project now is complete, and you are ready to quit Word. The following steps quit Word.

1. **Point to the Close button on the right side of the Word title bar (Figure 1–78).**
2. **Click the Close button to quit Word.**

Starting Word and Opening a Document

Once you have created and saved a document, you may need to retrieve it from your storage medium. For example, you might want to revise the document or reprint it. Opening a document requires that Word is running on your computer.

To Start Word

The following steps, which assume Windows is running, start Word.

1. **Click the Start button on the Windows taskbar to display the Start menu.**
2. **Point to All Programs on the Start menu to display the All Programs submenu and then point to Microsoft Office on the All Programs submenu to display the Microsoft Office submenu.**
3. **Click Microsoft Office Word 2007 on the Microsoft Office submenu to start Word and display a new blank document in the Word window.**
4. **If the Word window is not maximized, click the Maximize button on its title bar to maximize the window.**

BTW

If one or more of your borders do not print, click the Page Borders button on the Page Layout tab, click the Options button in the dialog box, click the Measure from box arrow and click Text, change the four text boxes to 15 pt, and then click the OK button in each dialog box. Try printing the document again. If the borders still do not print, adjust the text boxes in the dialog box to a number smaller than 15 point.
To Open a Document from Word

Earlier in this chapter you saved your project on a USB flash drive using the file name, Horseback Riding Lessons Flyer. The following steps open the Horseback Riding Lessons Flyer file from the USB flash drive.

1. With your USB flash drive connected to one of the computer’s USB ports, click the Office Button to display the Office Button menu (Figure 1–79).

Q&A
What files are shown in the Recent Documents list?
Word displays, by default, the nine most recently opened document file names in this list. If the name of the file you want to open appears in the Recent Documents list, you could click it to open the file.

2. Click Open on the Office Button menu to display the Open dialog box.

Q&A
How do I open the file if I am not using a USB flash drive?
Use the same process, but be certain to select your device in the Look in list.

Copyright 2008 Thomson Learning, Inc. All Rights Reserved.
May not be copied, scanned, or duplicated, in whole or in part.
Click the Open button to open the selected file and display the Horseback Riding Lessons Flyer document in the Word window (Figure 1–81).

Why is the Word icon and document name on the Windows taskbar?

When you open a Word file, a Word program button is displayed on the taskbar. The button in Figure 1–81 contains an ellipsis because some of its contents do not fit in the allotted button space. If you point to a program button, its entire contents appear in a ScreenTip, which in this case would be the file name followed by the program name.

Correcting Errors

After creating a document, you often will find you must make changes to it. For example, the document may contain an error, or new circumstances may require you to add text to the document.

Types of Changes Made to Documents

The types of changes made to documents normally fall into one of the three following categories: additions, deletions, or modifications.

Additions Additional words, sentences, or paragraphs may be required in a document. Additions occur when you omit text from a document and want to insert it later. For example, additional types of riding lessons may be offered.

Print Preview

You can preview a document before printing it by clicking the Office Button, pointing to Print, and then clicking Print Preview. When finished previewing the document, click the Close Print Preview button.
Deletions  Sometimes, text in a document is incorrect or is no longer needed. For example, group lessons might not be offered. In this case, you would delete the words, $25 for group lessons, from the flyer.

Modifications  If an error is made in a document or changes take place that affect the document, you might have to revise a word(s) in the text. For example, the fee per hour may change from $40 to $50 for private lessons.

To Insert Text in an Existing Document

Word inserts text to the left of the insertion point. The text to the right of the insertion point moves to the right and downward to fit the new text. The following steps insert the word, various, to the left of the word, aspects, in the flyer.

1. Scroll through the document and then click to the left of the location of text to be inserted (in this case, the a in aspects) to position the insertion point where text should be inserted (Figure 1–82).

2. Type various and then press the SPACEBAR to insert the word, various, to the left of the insertion point (Figure 1–83).

Q&A

Why did the text move to the right as I typed?

In Word, the default typing mode is insert mode, which means as you type a character, Word moves all the characters to the right of the typed character one position to the right. You can change to overtype mode by pressing the INSERT key on the keyboard. In overtype mode, Word replaces characters to the right of the insertion point. Pressing the INSERT key again returns Word to insert mode.
Deleting Text from an Existing Document

It is not unusual to type incorrect characters or words in a document. As discussed earlier in this chapter, you can click the Undo button on the Quick Access Toolbar to immediately undo a command or action — this includes typing. Word also provides other methods of correcting typing errors.

To delete an incorrect character in a document, simply click next to the incorrect character and then press the BACKSPACE key to erase to the left of the insertion point, or press the DELETE key to erase to the right of the insertion point.

To Select a Word and Delete It

To delete a word or phrase, you first must select the word or phrase. The following steps select the word, various, that was just added in the previous steps and then delete the selection.

1. Position the mouse pointer somewhere in the word to be selected (in this case, various), as shown in Figure 1–84.

2. Double-click the word to select it (Figure 1–85).

3. With the text selected, press the DELETE key to delete the selected text (shown in Figure 1–82).

Closing the Entire Document

Sometimes, everything goes wrong. If this happens, you may want to close the document entirely and start over with a new document. You also may want to close a document when you are finished with it so you can begin your next document. If you wanted to close a document, you would use the steps on the next page.
TO CLOSE THE ENTIRE DOCUMENT AND START OVER

1. Click the Office Button and then click Close.
2. If Word displays a dialog box, click the No button to ignore the changes since the last time you saved the document.
3. Click the Office Button and then click New on the Office Button menu. When Word displays the New Document dialog box, click Blank document and then click the Create button.

Word Help

At any time while using Word, you can find answers to questions and display information about various topics through **Word Help**. Used properly, this form of assistance can increase your productivity and reduce your frustrations by minimizing the time you spend learning how to use Word.

This section introduces you to Word Help. Additional information about using Word Help is available in Appendix C.

To Search for Word Help

Using Word Help, you can search for information based on phrases such as save a document or format text, or key terms such as copy, save, or format. Word Help responds with a list of search results displayed as links to a variety of resources. The following steps, which use Word Help to search for information about selecting text, assume you are connected to the Internet.

1. **Click the Microsoft Office Word Help button near the upper-right corner of the Word window to open the Word Help window.**

2. **Type select text** in the ‘Type words to search for’ text box at the top of the Word Help window (Figure 1–86).
• Press the ENTER key to display the search results.

• Click the Maximize button on the Word Help window title bar to maximize the Help window (Figure 1–87).

Where is the Word window with the Horseback Riding Lessons Flyer document?

Word is open in the background, but the Word Help window is overlaid on top of the Word window. When the Word Help window is closed, the document will reappear.

Figure 1–87

Q&A

• Click the Select text link to display information about selecting text (Figure 1–88).

What is the purpose of the buttons at the top of the Word Help window?

Use the buttons in the upper-left corner of the Word Help window to navigate through Help, change the display, show the Word Help table of contents, and print the contents of the window.

4

• Click the Close button on the Word Help window title bar to close the Word Help window and redisplay the Word window.

Figure 1–88

Copyright 2008 Thomson Learning, Inc. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.
Quick Reference
For a table that lists how to complete the tasks covered in this book using the mouse, Ribbon, shortcut menu, and keyboard, see the Quick Reference Summary at the back of this book, or visit the Word 2007 Quick Reference Web page (scsite.com/wd2007/qr).

**To Quit Word**

The following steps quit Word.

1. **Click the Close button on the right side of the title bar to quit Word.**

2. **If necessary, click the No button in the Microsoft Office Word dialog box so that any changes you have made are not saved.**

---

**Chapter Summary**

In this chapter you have learned how to enter text in a document, format text, insert a picture, format a picture, add a page border, and print a document. The items listed below include all the new Word skills you have learned in this chapter.

1. Start Word (WD 5)
2. Type Text (WD 13)
3. Display Formatting Marks (WD 14)
4. Wordwrap Text as You Type (WD 15)
5. Insert a Blank Line (WD 15)
6. Check Spelling and Grammar as You Type (WD 16)
7. Save a New Document (WD 19)
8. Apply Styles (WD 24)
9. Center a Paragraph (WD 26)
10. Select a Line (WD 27)
11. Change the Font Size of Selected Text (WD 28)
12. Change the Font of Selected Text (WD 29)
13. Select Multiple Paragraphs (WD 30)
14. Bullet a List of Paragraphs (WD 32)
15. Undo and Redo an Action (WD 32)
16. Select a Group of Words (WD 33)
17. Bold Text (WD 34)
18. Underline a Word (WD 35)
19. Italicize Text (WD 36)
20. Change the Style Set (WD 37)
21. Change Theme Colors (WD 39)
22. Change Theme Fonts (WD 39)
23. Insert a Picture (WD 41)
24. Apply a Picture Style (WD 44)
25. Change a Picture Border Color (WD 45)
26. Zoom the Document (WD 45)
27. Resize a Graphic (WD 46)
28. Add a Page Border (WD 48)
29. Change Spacing Above and Below Paragraphs (WD 50)
30. Change Document Properties (WD 51)
31. Save an Existing Document with the Same File Name (WD 53)
32. Print a Document (WD 54)
33. Quit Word (WD 55)
34. Open a Document from Word (WD 56)
35. Insert Text in an Existing Document (WD 58)
36. Select a Word and Delete It (WD 59)
37. Close the Entire Document and Start Over (WD 60)
38. Search for Word Help (WD 60)

---

If you have a SAM user profile, you may have access to hands-on instruction, practice, and assessment. Log in to your SAM account (http://sam2007.course.com) to launch any assigned training activities or exams that relate to the skills covered in this chapter.

---

**Certification**

The Microsoft Certified Application Specialist (MCAS) program provides an opportunity for you to obtain a valuable industry credential—proof that you have the Word 2007 skills required by employers. For more information, see Appendix F or visit the Word 2007 Certification Web page (scsite.com/wd2007/cert).
Learn It Online

Test your knowledge of chapter content and key terms.

Instructions: To complete the Learn It Online exercises, start your browser, click the Address bar, and then enter the Web address scsite.com/ wd2007/learn. When the Word 2007 Learn It Online page is displayed, click the link for the exercise you want to complete and then read the instructions.

Chapter Reinforcement TF, MC, and SA
A series of true/false, multiple choice, and short answer questions that test your knowledge of the chapter content.

Who Wants To Be a Computer Genius?
An interactive game that challenges your knowledge of chapter content in the style of a television quiz show.

Flash Cards
An interactive learning environment where you identify chapter key terms associated with displayed definitions.

Wheel of Terms
An interactive game that challenges your knowledge of chapter key terms in the style of the television show Wheel of Fortune.

Practice Test
A series of multiple choice questions that test your knowledge of chapter content and key terms.

Crossword Puzzle Challenge
A crossword puzzle that challenges your knowledge of key terms presented in the chapter.

Apply Your Knowledge

Reinforce the skills and apply the concepts you learned in this chapter.

Modifying Text and Formatting a Document

Instructions: Start Word. Open the document, Apply 1-1 Autumn Fest Flyer Unformatted, from the Data Files for Students. See the inside back cover of this book for instructions on downloading the Data Files for Students, or contact your instructor for information about accessing the required files.

The document you open is an unformatted flyer. You are to modify text, format paragraphs and characters, and insert a picture in the flyer.

Perform the following tasks:
1. Delete the word, entire, in the sentence of body copy below the headline.
2. Insert the word, Creek, between the text, Honey Farm, in the sentence of body copy below the headline. The sentence should end: ...Honey Creek Farm.
3. At the end of the signature line, change the period to an exclamation point. The sentence should end: ...This Year's Fest!
4. Apply the Heading 1 style to the headline. Apply the Heading 2 style to the signature line.
5. Center the headline and the signature line.
6. Change the font and font size of the headline to 48-point Cooper Black, or a similar font.
7. Change the font size of body copy between the headline and the signature line to 22 point.
8. Change the font size of the signature line to 28 point.
9. Bullet the three lines (paragraphs) of text above the signature line.
10. Bold the text, October 4 and 5.

Copyright 2008 Thomson Learning, Inc. All Rights Reserved. May not be copied, scanned, or duplicated, in whole or in part.
Apply Your Knowledge continued

11. Underline the word, and, in the first bulleted paragraph.
12. Italicize the text in the signature line.
13. Change the theme colors to the Civic color scheme.
14. Change the theme fonts to the Opulent font set.
15. Change the zoom to 50 percent so the entire page is visible in the document window.
16. Change the spacing before the headline paragraph to 0 point. Change the spacing after the headline paragraph to 12 point.
17. Insert the picture of the combine centered on the blank line above the bulleted list. The picture is called Fall Harvest and is available on the Data Files for Students. Apply the Snip Diagonal Corner, White picture style to the inserted picture. Change the color of the picture border to Orange, Accent 6.
18. The entire flyer now should fit on a single page. If it flows to two pages, resize the picture or decrease spacing before and after paragraphs until the entire flyer text fits on a single page.

19. Change the document properties, as specified by your instructor.
20. Click the Office Button and then click Save As. Save the document using the file name, Apply 1-1 Autumn Fest Flyer Formatted.
21. Submit the revised document, shown in Figure 1–89, in the format specified by your instructor.

Figure 1–89
Extend Your Knowledge

Extend the skills you learned in this chapter and experiment with new skills. You may need to use Help to complete the assignment.

Modifying Text and Graphics Formats

Instructions: Start Word. Open the document, Extend 1-1 Baseball Sign Ups Flyer, from the Data Files for Students. See the inside back cover of this book for instructions on downloading the Data Files for Students, or contact your instructor for information on accessing the required files.

You will enhance the look of the flyer shown in Figure 1–90.

Perform the following tasks:
1. Use Help to learn about the following formats: grow font, shrink font, change text color, decorative underline, and change bullet.
2. Select the headline and use the Grow Font button to increase its font size just enough so that the headline still fits on a single line. If it wraps to two lines, use the Shrink Font button.
3. Change the font color of all body copy between the headline and the signature line to a color other than Automatic, or Black.
4. Change the picture style of the picture so that it is not the Drop Shadow Rectangle picture style. Add a Glow picture effect to the picture of the baseball player.
5. Change the solid underline below the words, Indoor facility, to a decorative underline.
6. Change the color and width of the border.
7. Change the style of the bullets to a character other than the dot.
8. Change the document properties, as specified by your instructor. Save the revised document with a new file name and then submit it in the format specified by your instructor.

Figure 1–90
Make It Right

Analyze a document and correct all errors and/or improve the design.

Correcting Spelling and Grammar Errors

Instructions: Start Word. Open the document, Make It Right 1-1 New York Tour Flyer, from the Data Files for Students. See the inside back cover of this book for instructions on downloading the Data Files for Students, or contact your instructor for information on accessing the required files.

The document is a flyer that contains spelling and grammar errors, as shown in Figure 1–91. You are to correct each spelling (red wavy underline) and grammar error (green wavy underline) by right-clicking the flagged text and then clicking the appropriate correction on the shortcut menu. If your screen does not display the wavy underlines, click the Office Button and then click the Word Options button. When the Word Options dialog box is displayed, click Proofing, be sure the ‘Hide spelling errors in this document only’ and ‘Hide grammar errors in this document only’ check boxes do not have check marks, and then click the OK button. If your screen still does not display the wavy underlines, click the Recheck Document button in the Word Options dialog box.

Change the document properties, as specified by your instructor. Save the revised document with a new file name and then submit it in the format specified by your instructor.

Figure 1–91
In the Lab

Design and/or create a document using the guidelines, concepts, and skills presented in this chapter. Labs are listed in order of increasing difficulty.

Lab 1: Creating a Flyer with a Picture

Problem: You work part-time at Scenic Air. Your boss has asked you to prepare a flyer that advertises aerial tours over the city of Campton. First, you prepare the unformatted flyer shown in Figure 1–92a, and then you format it so that it looks like Figure 1–92b on the next page. Hint: Remember, if you make a mistake while formatting the flyer, you can click the Undo button on the Quick Access Toolbar to undo your last action.

Instructions: Perform the following tasks:
1. Display formatting marks on the screen.
2. Type the flyer text, unformatted, as shown in Figure 1–92a. If Word flags any misspelled words as you type, check the spelling of these words and correct them.
3. Save the document on a USB flash drive using the file name, Lab 1-1 Airplane Rides Flyer.
4. Apply the Heading 1 style to the headline. Apply the Heading 2 style to the signature line.
5. Center the headline and the signature line.
6. Change the font and font size of the headline to 48-point Arial Rounded MT Bold, or a similar font.
7. Change the font size of body copy between the headline and the signature line to 22 point.
8. Change the font size of the signature line to 28 point.
9. Bullet the three lines (paragraphs) of text above the signature line.
10. Bold the text, change your view.
11. Italicize the word, aerial.

Figure 1–92a
12. Underline the word, and, in the first bulleted paragraph.
13. Change the style set to the Formal.
14. Change the theme fonts to the Metro font set.
15. Change the zoom to 50 percent so the entire page is visible in the document window.
16. Change the spacing before the headline to 0 point. Change the spacing after the first paragraph of body copy to 0 point. Change the spacing before the first bulleted paragraph to 12 point.
17. Insert the picture on the blank line above the bulleted list. The picture is called Airplane Ride over City and is available on the Data Files for Students. Apply the Relaxed Perspective, White picture style to the inserted picture.
18. The entire flyer should fit on a single page. If it flows to two pages, resize the picture or decrease spacing before and after paragraphs until the entire flyer text fits on a single page.
19. Change the document properties, as specified by your instructor.
20. Save the flyer again with the same file name.
21. Submit the document, shown in Figure 1–92b, in the format specified by your instructor.
Lab 2: Creating a Flyer with a Picture and a Border

Problem: Your boss at Danvers Nursery has asked you to prepare a flyer that promotes its expanded greenhouses and grounds. You prepare the flyer shown in Figure 1–93. Hint: Remember, if you make a mistake while formatting the flyer, you can click the Undo button on the Quick Access Toolbar to undo your last action.

Instructions: Perform the following tasks:
1. Display formatting marks on the screen.
2. Type the flyer text, unformatted. If Word flags any misspelled words as you type, check the spelling of these words and correct them.
3. Save the document on a USB flash drive using the file name, Lab 1-2 Nursery Expansion Flyer.
4. Apply the Heading 1 style to the headline. Apply the Heading 2 style to the signature line.
5. Center the headline and the signature line.
6. Change the font and font size of the headline to 48-point Arial Rounded MT Bold, or a similar font.
7. Change the font size of body copy between the headline and the signature line to 22 point.
8. Change the font size of the signature line to 28 point.
9. Bullet the three lines (paragraphs) of text above the signature line.
10. Italicize the word, growing.
11. Bold the text, recently expanded.
12. Underline the word, and, in the third bulleted paragraph.
13. Change the style set to the Traditional.
14. Change the theme colors to the Solstice color scheme.
15. Change the theme fonts to the Flow font set.
16. Change the zoom to 50 percent so the entire page is visible in the document window.
17. Change the spacing before the headline to 0 point. Change the spacing after the first paragraph of
    body copy to 24 point. Change the spacing before the first bulleted paragraph to 12 point.
18. Insert the picture on the blank line above the bulleted list. The picture is called Bradford Pear in
    Bloom and is available on the Data Files for Students. Apply the Soft Edge Oval picture style to the
    inserted picture.
19. The entire flyer should fit on a single page. If it flows to two pages, resize the picture or decrease
    pacing before and after paragraphs until the entire flyer text fits on a single page.
20. Add the graphic border, shown in Figure 1–93 on the previous page (about one-third down in the
    Art gallery). Change the color of the border to Tan, Background 2.
21. Change the document properties, as specified by your instructor.
22. Save the flyer again with the same file name.
23. Submit the document, shown in Figure 1–93, in the format specified by your instructor.

In the Lab

Lab 3: Creating a Flyer with a Picture and Resized Border Art

Problem: Your neighbor has asked you to prepare a flyer that promotes her cabin rental business. You
prepare the flyer shown in Figure 1–94.

Instructions: Enter the text in the flyer, checking spelling as you type, and then format it as shown
in Figure 1–94. The picture to be inserted is called Paddle Boat on Lake and is available on the Data
Files for Students. After adding the page border, reduce the point size of its width so that the border
is not so predominant on the page. Change the document properties, as specified by your instructor.
Save the document on a USB flash drive using the file name, Lab 1-3 Cabin Rentals Flyer. Submit the
document, shown in Figure 1–94, in the format specified by your instructor.
Cases and Places

Apply your creative thinking and problem solving skills to design and implement a solution.

**EASIER  MORE DIFFICULT**

**1: Design and Create a Grand Reopening Flyer**

Your friend owns the Craft Barn, a large, year-round craft fair. She recently has renovated and remodeled the facility and is planning a grand reopening. She has asked you to create a flyer advertising this fact. The flyer should contain the following headline: Craft Barn. The first paragraph of text below the headline should read: Pick up a jar of homemade jam or a handcrafted gift at the completely remodeled and renovated Craft Barn, located at 8701 County Road 300 West. Insert the photograph named, Barn and Silo, which is available on the Data Files for Students. The bullet items

---

Copyright 2008 Thomson Learning, Inc. All Rights Reserved.
May not be copied, scanned, or duplicated, in whole or in part.
under the photograph should read as follows: first bullet – Expanded and paved parking; second bullet
– More than 150 booths; and third bullet – Open Monday through Saturday, 10:00 a.m. to 7:00 p.m.
The last line should read: Call 555-5709 for more information! Use the concepts and techniques
presented in this chapter to create and format this flyer. Be sure to check spelling and grammar.

• 2: Design and Create a Property Advertisement Flyer
As a part-time employee of Markum Realty, you have been assigned the task of preparing a flyer
advertising lakefront property. The headline should read: Lakefront Lot. The first paragraph of text
should read as follows: Build the house of your dreams or a weekend getaway on this beautiful lakeside
property located on the north side of Lake Pleasant. Insert the photograph named, Lake at Sunset,
which is available on the Data Files for Students. Below the photograph, insert the following bullet
items: first bullet — City sewer and water available; second bullet – Lot size 110 × 300; third bullet
– List price $65,000. The last line should read: Call Markum Realty at 555-0995 for a tour! Use the
concepts and techniques presented in this chapter to create and format this flyer. Be sure to check
spelling and grammar.

•• 3: Design and Create a Flyer for the Sale of a Business
After 25 years, your Uncle Mitch has decided to sell his ice cream shop and wants you to help him
create a sales flyer. The shop is in a choice location at the corner of 135th and Main Street and has
an established customer base. The building has an adjacent, paved parking lot, as well as an outdoor
seating area. He wants to sell the store and all its contents, including the equipment, tables, booths, and
chairs. The 1200-square-foot shop recently was appraised at $200,000, and your uncle is willing to sell
for cash or on contract. Use the concepts and techniques presented in this chapter to create and format
a sales flyer. Include a headline, descriptive body copy, a signature line, an appropriate photograph or
clip art image, a bulleted list, a decorative underline, and if appropriate, a page border. Be sure to check
spelling and grammar in the flyer.

•• 4: Design and Create a Flyer that Advertises You
Make It Personal
Everyone has at least one skill, talent, or special capability, which if shared with others, can lead to
opportunity for growth, experience, and personal reward. Perhaps you play a musical instrument. If
so, you could offer lessons. Maybe you are a skilled carpenter or other tradesman who could advertise
your services. If you speak a second language, you could offer tutoring. Budding athletes might harbor
a desire to pass on their knowledge by coaching a youth sports team. You may have a special knack
for singing, sewing, knitting, photography, typing, housecleaning, or pet care. Carefully consider
your own personal capabilities, skills, and talents and then use the concepts and techniques presented
in this chapter to create a flyer advertising a service you can provide. Include a headline, descriptive
body copy, a signature line, an appropriate photograph or clip art image, a bulleted list, a decorative
underline, and if appropriate, a page border. Be sure to check spelling and grammar in the flyer.

•• 5: Redesign and Enhance a Poorly Designed Flyer
Working Together
Public locations, such as stores, schools, and libraries, have bulletin boards or windows for people
to post flyers. Often, these bulletin boards or windows have so many flyers that some go unnoticed.
Locate a posted flyer on a bulletin board or window that you think might be overlooked. Copy the text
from the flyer and distribute it to each team member. Each member then independently should use this
text, together with the techniques presented in this chapter, to create a flyer that would be more likely
to catch the attention of passersby. Be sure to check spelling and grammar. As a group, critique each
flyer and have team members redesign their flyer based on the group’s recommendations. Hand in each
team member’s original and final flyers.